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Este documento possui as orientações e os 
regramentos dos elementos que compõem  
a marca Fundação Vale. 
 
Siga sempre as recomendações contidas nesse guia 
para garantir a consistência e a integridade da nossa 
marca. Em caso de dúvidas, consulte o ponto focal 
de comunicação da Fundação Vale.
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Identidade Visual Institucional e Territorial
Introdução  

Introdução
Nossa comunicação é feita por meio de duas abordagens: Identidade 
Visual Institucional e Identidade Visual Territorial. 
A Institucional fala sobre a Fundação de maneira mais corporativa e 
utiliza as cores do logo.  

Identidade Visual Institucional Identidade Visual Territorial

Cras sed nisi sed 
libero euismod 
auctor. Integer 
sagittis orci 
condimentum 
tellus condimentu, 
ut venenatis nulla.

Nulla finibus

Sed vulputate
diam auctor

Cras sed nisi sed 
libero euismod 
auctor diam.

Sed vulputate
diam auctor

Já a Territorial abre espaço o uso das outras cores da paleta principal e 
uma cor da paleta secundária. Incorpora elementos gráficos dos 
territórios em que está inserida com a finalidade de conversar 
diretamente com o local.



Logo

Cores do Logo

Fotografia

Tipografia

Cores

Cores

Composição

Composição

One page

One page

Boas práticas

Boas práticas

Identidade
Visual

Institucional

Territorial

Uso interno - Desenvolvido pela Gerência de Marca & Publicidade

Elementos Gráficos
Introdução

Introdução
A Identidade Visual Institucional e a Identidade Visual Territorial da 
Fundação Vale compartilham o mesmo logo, estilo fotográfico e tipografia. 
Ambas também possuem os mesmos  grafismos, mas estes se comportam 
de maneiras diferentes: na Identidade Institucional os grafismos só poderão 

Logo

Paleta e proporção cromática da identidade institucional 

Grafismos: Grafismos:

Paleta e proporção cromática da identidade territorial

Contornos ContornosCaixas CaixasIlustrações Ilustrações

Elementos gráficos comuns

Elementos gráficos particulares

Institucional Territorial

Cores do Logo Estilo Fotográfico Tipografia

aparecer nas cores Verde Vale, Amarelo Vale e Branco; e na Identidade 
Territorial os grafismos abrangem mais cores e podem ser personalizados 
quando estiverem falando sobre algum tema específico dentro de um 
território. Você terá mais informações no decorrer deste manual.

Vale Sans Light
Vale Sans Medium
Vale Sans Bold
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Conceito criativo
Logo

Logo

Introdução

Abraço: 
Envolvimento

Encontro: 
Fazer junto

Aspa: 
Diálogo com 
a sociedade

O símbolo da Fundação Vale nasce de conceitos que representam a ideia 
de contribuição com o desenvolvimento dos territórios onde operamos. 
Ao abraçar esses conceitos, a Fundação Vale amplia e potencializa 
milhares de vozes. E esse movimento passa a fazer parte da nossa 
identidade visual.
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Versão Preferencial
Logo

Logo

Versão preferencial: essa aplicação deve ser sempre priorizada. 
O não uso dessa versão é válido somente em casos de impedimentos técnicos.

A versão positiva colorida é a que melhor destaca o nosso logo, seus detalhes 
e suas cores. Ela oferece melhor leitura e um reconhecimento mais fácil e rápido. 
Por isso, esta é a versão preferencial e tem seu uso priorizado.
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English version
Logo

Logo



Cores

Introdução
A versão monocromática deve ser usada quanto houver a limitação de apenas 
uma cor de uso, ou quando o logo precisar ser aplicado sobre fundos coloridos.

Monocromática Negativa Monocromática Positiva

Boas práticas

One page

Composição

Cores

Territorial

Boas práticas

One page

Composição

Institucional

Fotografia

Tipografia

Cores do Logo

Logo

Identidade
Visual

Deve ser utilizada apenas quando 
houver um fundo de cor ou 
imagem que não afete a 
visibilidade da marca.

Monocromática Negativa Monocromática Positiva

Deve ser aplicada quando houver 
a necessidade de uma cor sólida 
para atender às necessidades de 
produção, como fax, alto relevo, 
hot stamping, corte especial, etc.

Uso restrito: Utilize somente quando não for 
possível a aplicação em mais de uma cor.

Uso interno - Desenvolvido pela Gerência de Marca & Publicidade

Versões Restritas
Logo
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Versão em tons de cinza
Logo

Logo Use apenas em impressões em escala de cinza. Para fundos de cores escuras, 
use a versão negativa e, para fundos de cores claras use a versão positiva. 
Sempre preste atenção no contraste entre o logotipo e o plano de fundo.

 
Pantone Cool Gray 4C 
C 0 M 0 Y 0 K 30 
R 171 G 171 B 171 
HEX #ABABAB

 
Pantone Dark Grey 
C 0 M 0 Y 0 K 75 
R 48 G 48 B 48 
HEX #303030

Uso restrito: Utilize somente quando não for 
possível a aplicação em mais de uma cor.
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Reserva e redução
Logo

Logo A área de reserva e a redução máxima garantem a 
leitura, o reconhecimento e a preservação dos elementos 
que compõem a nossa marca.

A área de reserva é definida a partir da altura x de nosso logotipo. 
Não desrespeite essa área em hipótese nenhuma.

X

X

Área de reserva Redução máxima

8 mm 
Impressão 

 
20 px 

Digital
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Convivência
Logo

Logo Quando o logo é aplicado com outra marca, sempre respeite a distância 
mínima usando como referência a largura do nome “VALE”.

Exemplo

Lembre-se de aplicar ajuste ótico à regua de logos. Em alguns casos, a altura do logo da 
outra marca pode ser maior ou menor que o logo da Fundação Vale. Isto acontece para 
que haja uma compensação e ambos possam ter a mesma força em suas presenças.
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Quando o logo é aplicado com outra marca, sempre respeite a distância 
mínima usando como referência a largura do nome “VALE”.

Lembre-se de aplicar ajuste ótico à regua de logos. Em alguns casos, a altura do logo da 
outra marca pode ser maior ou menor que o logo do Instituto Cultural Vale. Isto acontece 
para que haja uma compensação e ambos possam ter a mesma força em suas presenças.

Exemplo vertical

Convivência
Logo
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O que não fazer
Logo

Logo Veja a seguir, alguns exemplos do que não fazer com o nosso logo. 
Estas regras garantem a consistência e legibilidade e devem ser 
respeitadas em todas as versões do logo da Fundação Vale.

Não distorça

Não rotacione

Não aplique a versão preferencial 
sobre fundo preto

Não reproduza o logo 
com outra tipografia 

Não aplique sombras

Não aplique sobre fundo que 
não garanta o contraste

Não invada a área de proteção

Não aplique sobre transparências 
de outras cores

Não aplique contorno

FUNDacão 
VALE

Aquo molut abore, core, ulla nes atium aut repraest 
aborum aute lam et dolut mintur as vel in conseque 
molut aute parumenis eum repudam dolupti onecto 
volor aut que dolest aceaturios intiorr oviducienis et vo-
lupta tiassus cilluptatem intis consequassi aniasped qui-
atem ut aut ullaut molo te cum dolorem fuga. Qui aut 
quates mos quis sandanit enducim ilitatusam et alique 
nataspel ima dolorescia non plis aut laut ommoluptam 
reriam sunteca epudita quuntur, consequam non cum 
as maximin ihillorio. Tempel inis acit qui

Não use outras cores além das 
mostradas neste manual

Não altere a estrutura, ou 
posição dos elementos

Não aplique o logo sobre 
outras cores de fundo

Use apenas as arte-finais oficiais 
que foram disponibilizadas. 
Não recrie o logo.
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Aplicações sobre fundos
Logo

Logo

Branco

Cores escuras contrastantes com branco

Cores claras contrastantes com preto

Imagens com cores claras

Imagens que contrastem com branco

Imagens que contrastem com preto

Materiais claros

Materiais escuros

Materiais coloridos

Veja a seguir, alguns exemplos de aplicações possíveis com o nosso logo. 
Estas regras garantem a consistência e legibilidade e devem ser 
respeitadas em todas as versões do logo da Fundação Vale.

Aplicações da versão preferencial

Aplicações da versão monocromática negativa

Aplicações da versão monocromática positiva
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O que não fazer
Logo

Logo Veja a seguir, alguns exemplos do que não fazer com o nosso logo. Estas 
regras garantem a consistência e legibilidade e devem ser respeitadas em 
todas as versões do logo da Fundação Vale.

Não utilize sobre imagens com grande 
quantidade de informação

Não utilize sobre imagens com grande 
quantidade de informação

Não utilize sobre imagens com 
grande quantidade de informação

Não utilize sobre as mesmas 
cores da marca

Não utilize sobre o mesmo 
tom da marca

Não utilize sobre o mesmo 
tom da marca

Não utilize sobre cores que 
dificultam a leitura da marca

Não utilize sobre imagens 
não constrastantes

Não utilize sobre imagens 
não contrastantes

Aplicações da versão preferencial

Aplicações da versão monocromática negativa

Aplicações da versão monocromática positiva
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Posição
Logo

Logo

Cras sed nisi sed libero euismod 
auctor. Integer sagittis orci  
lorem ipsum consectetur.

Sed vulputate
diam auctor

Cras sed nisi sed libero 
euismod auctor. 
Integer sagittis orci 
condimentum tellus 
condimentum, ut 
venenatis nulla finibus 
pellentesque.itant 
morbi.

Nulla finibus

Sed vulputate
diam auctor

Exemplo

A posição do nosso logo nas peças de comunicação também precisa de 
atenção. Veja a seguir, alguns exemplos de como aplicá-lo. Estas regras 
garantem a consistência e legibilidade e devem ser respeitadas em todas 
as aplicações.

Encontre o valor da margem

A

As margens da moldura devem medir entre  
3% e 6% da menor medida do formato,  no 
caso, representado pela letra “X”.

3% a 6% 
da menor 
medida do 
formato.

X

B

C D

Aplique o logo
O logo poderá aparecer em qualquer um 
dos cantos do layout (A, B, C e D).
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Cores do logo
Logo

Cores do Logo

Logo Essas são as cores do nosso logo. Estas cores devem ser utilizadas em 
todas as nossas aplicações.

Amarelo-Vale

Verde-Vale

C00 M00 Y00 K00 
R255 G255 B255 
#FFFFFF

Branco

Brilho 
 
Pantone 124 C 
C00 M30 Y00 K08 
R237 G177 B17 
#ECB11F

Fosco 
 
Pantone 7406 U 
C00 M20 Y100 K05 
R237 G177 B17 
#ECB11F

Brilho 
 
Pantone 328 C 
C100 M10 Y55 K10 
R000 G126 B122 
#007E7A

Fosco 
 
Pantone 328 U 
C100 M20 Y60 K0 
R000 G126 B122 
#007E7A

Pantone Cool Gray 9 C 
C00 M00 Y00 K65 
R116 G118 B120 
#747678

Cinza-Vale
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Tipografia 

Tipografia

Vale Sans

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890#@!?/.+=$%&

Light    
Light italic

Medium   
Medium Italic

Bold    
Bold Italic

Temos 6 pesos principais:

A Vale Sans é versátil

A Vale Sans está disponível na 
página de marca da intranet 
global. Caso não tenha acesso, 
solicite à Equipe de Comunicação.

A tipografia é parte importante da nossa identidade visual, por isso, seu 
uso correto e sistemático ajuda a criar uma imagem consistente e 
organizada. A Vale Sans pode ser distribuída sem qualquer tipo de 
limitação, facilitando a utilização e garantindo a consistência de materiais 
internos e externos. Também poderá ser usada em websites e aplicativos.
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Cras sed nisi sed 
libero euismod 
auctor. Integer 
sagittis orci 
condimentum 
tellus condimentu, 
ut venenatis nulla.

Nulla finibus

Sed vulputate
diam auctor

Principais - como usar
Tipografia 

Tipografia

Os recursos da tipografia e da diagramação trazem personalidade à 
nossa identidade visual e ajudam a tornar nossas mensagens mais 
inspiradoras. O peso das fontes recomendadas pode ser ajustado 
para dar ênfase às informações importantes quando necessário.

Títulos e destaques: 

Vale Sans Regular, Medium ou Bold.

Se o título estiver em um tamanho maior, que se destaque do texto corrido, podemos 
optar pelo peso regular. Caso o título tenha tamanho igual ou parecido com o texto, o 
medium e o bold são recomendados para manter a hierarquia de leitura.

Textos corridos: 

Vale Sans Light ou Regular.

Legendas: 

Vale Sans Light ou Regular.

Devemos alinhar todos os textos à esquerda.
Textos legais, notas de rodapé e trechos 
traduzidos podem estar em itálico, se precisar. 
Não utilizar texto em CAIXA-ALTA!
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Exemplos
Fotografia

Fotografia

A fotografia da Fundação Vale retrata um olhar próximo, positivo e 
verdadeiro do cotidiano das pessoas dos territórios onde atuamos. 
Imagens que reverberam o cuidado, diálogo e envolvimento na nossa 

atuação juntamente com aqueles que recebem, colaboram e melhoram 
com a gente.
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O que não fazer
Fotografia 

Fotografia

Veja, abaixo, algumas fotos que não podem fazer parte da identidade:

Não use fotos muito escuras Não use fotos posadas ou situações clichês

Não use fotos com efeitos ou filtros

Não use fotos com ilustrações ou interferências gráficas

Não use fotos em preto e branco

x x x

x x

x



Identidade Visual 
Institucional
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Cores da identidade
Cores  

Cores

Essas são as nossas cores principais que devem 
ser utilizadas em todas as nossas aplicações. 
Para essa marca não usaremos as cores em retículas.

Amarelo-Vale

Verde-Vale

C00 M00 Y00 K00 
R255 G255 B255 
#FFFFFF

Branco

Brilho 
 
Pantone 124 C 
C00 M30 Y00 K08 
R237 G177 B17 
#ECB11F

Fosco 
 
Pantone 7406 U 
C00 M20 Y100 K05 
R237 G177 B17 
#ECB11F

Brilho 
 
Pantone 328 C 
C100 M10 Y55 K10 
R000 G126 B122 
#007E7A

Fosco 
 
Pantone 328 U 
C100 M20 Y60 K0 
R000 G126 B122 
#007E7A

Pantone Cool Gray 9 C 
C00 M00 Y00 K65 
R116 G118 B120 
#747678

Cinza-Vale
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Barra de proporções
Cores

Cores

A barra de proporções é um guia para que as cores sejam aplicadas da 
forma correta. Ela nos ajuda a determinar o espaço que cada cor ocupa, 
garantindo a consistência cromática de nossa marca.

Principais Branco Cinza
Devem estar obrigatoriamente 
presentes nos materiais da Fundação  Vale.

Áreas em branco trazem a ideia de luz 
e garantem leveza às nossas peças.

Os textos em cinza trazem 
a ideia de consistência.
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Contorno
Composição

Composição

O contorno em várias camadas tem a intenção de indicar atitudes, ideias e ações 
sendo multiplicadas e reverberadas. As forças deste elemento são a sua massa de 
cor bem presente, a flexibilidade da sua forma e a integração fluida que ele 
apresenta com nossas fotos. A seguir, você confere como utilizar o contorno.

Construção 

Cras sed nisi sed libero 
euismod auctor. Integer 
sagittis orci condimentum 
tellus condimet, ut venenatis 
nulla finibus 
pellentesque.itant morbi.

Nulla finibus

Sed vulputate diam
in ex congue auctor

Exemplos

No Adobe Illustrator, selecione a ferramenta Brush. Em seguida, 
abra a aba de tipos de brushes e escolha um dos contornos.

A forma-base do Contorno foi construída pela 
intercalação das cores Verde Vale, Amarelo Vale e 
Branco.

Desenhe contornando a silhueta do assunto que queira dar destaque: uma pessoa, 
um objeto, uma paisagem, etc. Ao contornar a forma, utilize poucos detalhes. A 
ideia não é ser fiel ao desenho, mas sim, referenciá-lo de um jeito simples.

Você encontra os contornos em 
formato de “brush” nos arquivos 
fornecidos junto a este guia.
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Contorno
Composição  

Composição

Os contornos devem transmitir a ideia de reverberação do assunto da foto. 
Por isso, o correto controle da espessura e proporção desse elemento é 
fundamental para que essa mensagem seja transmitida sem ruídos.

Durante o desenvolvimento, caso apareça algum defeito 
nos contornos como no exemplo ao lado, basta diminuir 
um pouco a espessura até que o defeito suma.

Espessura e Proporção

Resolvendo possíveis defeitos

Não utilize contornos finos. A força do 
contorno está na sua massa de cor bem 
presente.

Contornos com espessura média são os ideais. 
Esta espessura marca bem o layout, ao mesmo 
tempo que não disputa atenção com imagens e 
textos.

Contornos grossos são permitidos, mas deve-
se ter atenção aos outros elementos do 
layout.  Quando houver a presença desta 
espessura, é aconselhável que não se utilize 
texto. Caso seja necessária a presença de texto, 
ele deve aparecer distante do contorno.

x

Você encontra os contornos em 
formato de “brush” nos arquivos 
fornecidos junto a este guia.
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Caixas
Composição  

Composição

Uma maneira bem simples de contar nossa história é através das 
caixas. Elas possuem função de abrigar textos e são excelentes janelas 
para as nossas fotos. A seguir, você confere detalhes de como as 
caixas foram construídas.

ExemplosConstrução

As formas-base das caixas 
são geométricas e simples

Lorem Ipsum
Dolor Sit Amet

Lorem ipsum dolor sit 
amet, consectetur 
adipiscing elit, sed do 
eiusmod tempor 
incididunt ut labore et 
dolore magna aliqua.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Você encontra caixas já prontas pra 
uso nos arquivos fornecidos junto a 
este guia.

Foi aplicado o mesmo brush dos contornos nas linhas das 
formas-base para atingir o resultado abaixo.
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Caixas
Composição

Composição Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit amet, 
consectetuer adipiscing elit, 
sed diam nonummy nibh 
euismod tinci.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit amet, 
consectetuer adipiscing elit, 
sed diam nonummy nibh 
euismod tinci.

As caixas podem aparecer de maneira mais integrada às fotos 
ao retirarmos as formas que as compõem. Abaixo você confere 
a melhor forma de usar este recurso.

Usos e Proporção

Resolvendo possíveis defeitos

Não utilize contornos finos.  
A força do contorno está na sua 
massa de cor bem presente.

Contornos com espessura média 
são os ideais. Esta espessura marca 
bem o layout, ao mesmo tempo 
que não disputa atenção com 
imagens e textos.

É possível utilizar a parte mais 
interna do box como janela 
para fotografias. Este tipo de 
aplicação é ideal para destacar 
situações em uma imagem.

A parte do meio do box também 
pode ser vazada. Neste caso, opte 
por imagens mais limpas e que não 
interfiram no entendimento do 
formato da caixa. 

x

Você encontra as caixas já prontas 
pra uso nos arquivos fornecidos 
junto a este guia.

Durante o desenvolvimento, caso apareça algum defeito nos 
contornos como no exemplo ao lado, basta diminuir um pouco 
a espessura até que o defeito suma. Mantenha sempre a 
aparência do balão central próxima à sua forma-base
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Ilustração
Composição 

Composição

As ilustrações enriquecem nossa identidade visual e são indicadas para 
peças mais livres, que tenham a intenção de agregar um valor mais 
artístico. A seguir, você confere detalhes para a construção de novas 
ilustrações.

ExemplosConstrução

As formas-base das ilustrações são sempre simples e 
com baixa complexidade de detalhes. Para que possam 
ter o efeito de reverberação, precisam ter o efeito de 
Offset Path aplicado.

Aplique efeito de offset pelo menos três vezes no 
objeto. Para fazer isso, no Adobe Illustrator, selecione o 
objeto e siga o caminho no menu: 
Object -> Path -> Offset Path -> Offset = valor de 1/3 da 
largura do objeto. Selecione a forma recém-criada e repita 
o passo mantendo o mesmo valor de offset.

Você encontra ilustrações já prontas 
pra uso nos arquivos fornecidos 
junto a este guia.
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Resumo da identidade institucional
One Page 

One page

Composição

O painel abaixo mostra o resumo da identidade com os 
principais elementos do universo visual da Fundação Vale. 
 
Respeite proporção de cores na régua deste resumo.

Todos as versões dos logos da Fundação Vale estão disponíveis no Pacote 
de Identidade Visual que acompanha este guia. Lá você também 
encontra os grafismos em modo editável e layouts editáveis para 
consulta.

Cras sed nisi sed 
libero euismod 
auctor. Integer 
sagittis orci 
condimentum 
tellus condimentu, 
ut venenatis nulla.

Nulla finibus

Sed vulputate
diam auctor

Lorem Ipsum
Dolor Sit Amet

Lorem ipsum dolor sit 
amet, consectetur 
adipiscing elit, sed do 
eiusmod tempor 
incididunt ut labore et 
dolore magna aliqua.

Vale Sans Thin 
Vale Sans Regular 
Vale Sans Semibold 
Vale Sans Extra Bold

Vale Sans Light
Vale Sans Medium
Vale Sans Bold
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Boas práticas
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Boas práticas
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Boas práticas



Identidade Visual 
Territorial
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Paleta
Cores

Cores

Essas são as nossas cores principais que devem ser utilizadas em todas as nossas 
aplicações. Para essa marca não usaremos as cores em retículas.

Paleta Secundária

Paleta Primária

Amarelo-Vale

Verde-Vale

C00 M00 Y00 K00 
R255 G255 B255 
#FFFFFF

Branco

Pantone 151 C 
C00 M55 Y90 K00 
R227 G114 B34 
#E37222

Laranja-Vale
Pantone 3395 C 
C80 M00 Y55  K00 
R10 G187 B152 
#0ABB98

Aqua-Vale
Pantone Rubine Red C 
C20 M100 Y50 K00 
R192 G48 B94 
#C0305E

Cereja-Vale
Pantone 298 C 
C70 M00 Y00 K00 
R60 G181 B229 
#3CB5E5

Azul-ValeAzul-escuro
C85 M70 Y00 K00 
R38 G38 B209 
#2626d1

Brilho 
 
Pantone 124 C 
C00 M30 Y00 K08 
R237 G177 B17 
#ECB11F

Fosco 
 
Pantone 7406 U 
C00 M20 Y100 K05 
R237 G177 B17 
#ECB11F

Brilho 
 
Pantone 328 C 
C100 M10 Y55 K10 
R000 G126 B122 
#007E7A

Fosco 
 
Pantone 328 U 
C100 M20 Y60 K0 
R000 G126 B122 
#007E7A

Cinza-Vale 
 
Pantone Cool Gray 9 C 
C00 M00 Y00 K65 
R116 G118 B120 
#747678
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Barra de proporções
Cores

Cores

A barra de proporções é um guia para que as cores sejam aplicadas da 
forma correta. Ela nos ajuda a determinar o espaço que cada cor ocupa, 
garantindo a consistência cromática de nossa marca.

Verde-Vale Amarelo-Vale, Laranja-Vale, Cereja-Vale, 
Azul-escuro, Azul-Vale e Aqua-Vale

Branco Cinza Escuro
Deve estar 
obrigatoriamente 
presente em todos 
os materiais da 
comunicação 
territorial

Trazem alegria aos nossos layouts. Escolha no máximo 
três dessas cores para compor o layout

Áreas em branco 
trazem a ideia de 
luz e garantem 
leveza às nossas 
peças.

Os textos em cinza 
trazem a ideia de 
consistência.
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Contorno
Composição  

Composição

O contorno em várias camadas tem a intenção de indicar atitudes, ideias e ações 
sendo multiplicadas e reverberadas. As forças deste elemento são sua massa de 
cor bem presente, a flexibilidade da sua forma e a integração fluida que ele 
apresenta com nossas fotos. A seguir, você confere como utilizar o contorno.

Construção Exemplo

No Adobe Illustrator, selecione a ferramenta Brush. Em seguida, 
abra a aba de tipos de brushes e escolha um dos contornos.

A forma-base do Contorno foi construída pela 
intercalação de três cores da identidade territorial

Desenhe contornando a silhueta do assunto que queira dar destaque: uma pessoa, 
um objeto, uma paisagem, etc. Ao contornar a forma, utilize poucos detalhes. A 
ideia não é ser fiel ao desenho, mas sim, referenciá-lo de um jeito simples.

Você encontra os contornos em 
formato de “brush” nos arquivos 
fornecidos junto a este guia.
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Contorno
Composição  

Composição

Os contornos devem transmitir a ideia de reverberação do assunto da foto. 
Por isso, o correto controle da espessura e proporção desse elemento é 
fundamental para que essa mensagem seja transmitida sem ruídos.

Durante o desenvolvimento, caso apareça algum defeito 
nos contornos como no exemplo ao lado, basta diminuir 
um pouco a espessura até que o defeito suma.

Espessura e Proporção

Resolvendo possíveis defeitos

Não utilize contornos finos. A força do 
contorno está na sua massa de cor bem 
presente.

Contornos com espessura média são os ideais. 
Esta espessura marca bem o layout, ao mesmo 
tempo que não disputa atenção com imagens e 
textos

Contornos grossos são permitidos, mas deve-
se ter atenção aos outros elementos do 
layout.  Quando houver a presença desta 
espessura, é aconselhável que não se utilize 
texto. Caso seja necessária a presença de texto, 
ele deve aparecer distante do contorno.

x

Você encontra os contornos em 
formato de “brush” nos arquivos 
fornecidos junto a este guia.
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Contorno personalizado
Composição  

Composição

Além dos contornos em cor, existe a possibilidade de criar contornos com desenhos derivados da 
cultura local. A ideia é que eles possam ser misturados aos contornos coloridos e dêem mais carga 
local ao assunto que está sendo falado.

Construção Exemplos

Somam-se às formas-base dos contornos territoriais mais opções 
com o branco, pois a ideia é que os novos contornos criados possam 
ser colocados em cima da área em branco também.

Para criar um novo contorno, utilize o Adobe Illustrator e siga os passos 
abaixo. Depois disso o novo contorno será adicionado à lista de brushes.

Construa uma 
unidade da 
forma. Tenha em 
mente que ela 
será replicada ao 
decorrer do 
contorno

Window 
Brushes 
New Brush

Siga as 
configurações 
mostradas ao lado 
ou adapte-as para 
o seu brush

#LoremIpsum

Dias 5 e 6
de dezembro

Mauris suscipit
lectus justo
vel dignissim

Vivamus venenatis arcu 
a molestie porttitor
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Caixas
Composição 

Composição

Uma maneira bem simples de contar nossa história é através das caixas. 
Elas possuem função de abrigar textos e são excelentes janelas para as 
nossas fotos. A seguir, você confere detalhes de como as caixas foram 
construídas.

ExemplosConstrução

As formas-base das caixas 
são geométricas e simples

Lorem Ipsum
Dolor Sit Amet

Lorem ipsum dolor sit 
amet, consectetur 
adipiscing elit, sed do 
eiusmod tempor 
incididunt ut labore et 
dolore magna aliqua.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Você encontra as caixas já prontas 
pra uso nos arquivos fornecidos 
junto a este guia.

Foi aplicado o mesmo brush dos contornos nas linhas 
das formas-base para atingir o resultado abaixo.
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Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Lorem ipsum
dolor sit amet

Lorem ipsum dolor sit 
amet, consectetuer 
adipiscing elit, sed 
diam nonummy nibh 
euismod tinci.

Caixas
Composição 

Composição

As caixas podem aparecer de maneira mais integrada às fotos ao 
retirarmos as formas que as compõem. Abaixo você confere a melhor 
forma de usar este recurso.

Durante o desenvolvimento, caso apareça algum defeito nos 
contornos como no exemplo ao lado, basta diminuir um 
pouco a espessura até que o defeito suma. Mantenha sempre 
a aparência do balão central próxima à sua forma-base.

Usos e Proporção

Resolvendo possíveis defeitos

Não utilize contornos finos.  
A força do contorno está na sua 
massa de cor bem presente.

Contornos com espessura média 
são os ideais. Esta espessura marca 
bem o layout, ao mesmo tempo que 
não disputa atenção com imagens e 
textos.

É possível utilizar a parte mais 
interna da caixa como janela 
para fotografias. Este tipo de 
aplicação é ideal para destacar 
situações em uma imagem.

A parte do meio do box 
também pode ser vazada. Neste 
caso, opte por imagens mais 
limpas e que não interfiram no 
entendimento do formato da 
caixa. 

x

Você encontra as caixas já prontas 
pra uso nos arquivos fornecidos 
junto a este guia.
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Ilustração
Composição 

Composição

As ilustrações enriquecem nossa identidade visual e são indicadas para peças mais 
livres, que tenham a intenção de agregar um valor mais artístico. A seguir, você 
confere detalhes para a construção de novas ilustrações.

ExemplosConstrução

As formas-base das ilustrações são sempre simples e 
com baixa complexidade de detalhes. Para que possam 
ter o efeito de reverberação, precisam ter o efeito de 
Offset Path aplicado.

Aplique efeito de offset pelo menos três vezes no 
objeto. Para fazer isso, no Adobe Illustrator, selecione o 
objeto e siga o caminho no menu: 
Object -> Path -> Offset Path -> Offset = valor de 1/3 da 
largura do objeto. Selecione a forma recém-criada e 
repita o passo mantendo o mesmo valor de offset.

Você encontra ilustrações já prontos 
pra uso nos arquivos fornecidos 
junto a este guia.
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Exemplo - Rio de Janeiro
Composição

Composição

Introdução
Abaixo você confere o exemplo de uma aplicação mais livre utilizando 
referências territoriais.

Padrões personalizados 
para cada território. 
Inspirados na cultura local.

Cores baseadas no assunto 
territorial e adaptadas à 
paleta da Vale.

Paisagem do Rio

Calçada de Copacabana
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Exemplo - Maranhão
Composição 

Composição

Introdução

Padrões personalizados 
para cada território. 
Inspirados na cultura local.

Cores baseadas no assunto 
territorial e adaptadas à 
paleta da Vale.

Fitas

Babaçu

Abaixo você confere o exemplo de uma aplicação mais livre utilizando 
referências territoriais.
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Resumo da identidade territorial
One page

One page

O painel abaixo mostra o resumo da identidade com os 
principais elementos do universo visual da Fundação Vale. 
 
Respeite proporção de cores na régua deste resumo.

Todos as versões dos logos da Fundação Vale estão disponíveis no Pacote 
de Identidade Visual que acompanha este guia. Lá você também 
encontra os grafismos em modo editável e layouts editáveis para 
consulta.

Cras sed nisi sed 
libero euismod 
auctor diam.

Sed vulputate
diam auctor

Lorem Ipsum
Dolor Sit Amet

Lorem ipsum dolor sit 
amet, consectetur 
adipiscing elit, sed do 
eiusmod tempor 
incididunt ut labore et 
dolore magna aliqua.

Vale Sans Thin 
Vale Sans Regular 
Vale Sans Semibold 
Vale Sans Extra Bold

Vale Sans Light
Vale Sans Medium
Vale Sans Bold



Logo

Introdução

Cores do Logo

Fotografia

Tipografia

Cores

Cores

Composição

Composição

One page

One page

Boas práticas

Identidade
Visual

Institucional

Territorial

Boas práticas

Boas práticas

Uso interno - Desenvolvido pela Gerência de Marca & Publicidade



Logo

Introdução

Cores do Logo

Fotografia

Tipografia

Cores

Cores

Composição

Composição

One page

One page

Boas práticas

Identidade
Visual

Institucional

Territorial

Boas práticas

Uso interno - Desenvolvido pela Gerência de Marca & Publicidade



Logo

Introdução

Cores do Logo

Fotografia

Tipografia

Cores

Cores

Composição

Composição

One page

One page

Boas práticas

Identidade
Visual

Institucional

Territorial

Boas práticas

Boas práticas

Uso interno - Desenvolvido pela Gerência de Marca & Publicidade



Para que a nossa marca seja bem 
construída, todos precisam seguir 
as recomendações deste manual.

Se você quiser saber mais, se não 
encontrou aqui a informação
que buscava ou se tiver 
sugestões, entre em contato com 
o ponto focal de comunicação da 
Fundação Vale.
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